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PREFACE

This Guideline was prepared by the Australian New Zealand Land Information Council
(ANZLIC) National Nested Grid (NNG) Workgroup.

This Guideline provides the detailed specification of a spatial framework to organise new or
existing grid cell (also called raster or gridded) data for people who are data users, data
custodians or responsible for data capture or generation. This guideline provides the spatial
consistency needed for efficient sharing and reuse of grid cell data that is generated and
managed in different sources and multiple resolutions.

The reasons for production of this Guideline are as follows:

The rapid growth in grid cell (raster) based data availability and analysis;

The need to meet international obligations in sharing grid cell data;

That government decision making processes are increasingly reliant on this type of data;
The increasing desire to share information across domains and observation types; and

The strong interest of the ANZLIC Council to sponsor standards that underpin the
Australia and New Zealand spatial data infrastructures.

The specifications in this guide are selected based on the context of use discussed in a
workshop and the details gathered through an online survey of the members of the
Workgroup and their nominated participants. The context of use includes the following:

e International collaboration using datasets based on gridded data;

e Maintaining the accuracy of the observations stored in a gridded dataset;

e Future proofing measurements and observations in grid cell format in relation to changes
in datums, map projections and the specifications that define the shape of the earth
surface; and

e Computer manipulation of the measurements stored in grid cell format.

The Guideline does not contribute to the authority of the contained data. The specifications
are a set of compromises and will not suit all requirements. The basis for evaluation and
selection of the components of this Guideline uses the following criteria:

Feedback from key domain and jurisdictional representatives;
Ensuring consistency across domains considered:;

Impact on future data management tasks; and

Reuse of existing data.
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SECTION 1 SCOPE AND GENERAL

1.1 SCOPE

1.1.1 GENERAL CONFORMANCE

This specification guide does not replace the need to build geospatial solutions but provides

the spatial consistency needed to allow two or more organisations to work with greater data

interoperability and ensure that there will be a minimum of rework and re-sampling required
to use existing or new data and to use the final fused results.

As the size of this data increases with the improvement of sensors and collection frequencies,
the cost of reformatting this data for analyses begins to impinge the ability to do the analyses.
This can be reduced by adoption of a set of agreed specifications for Australian and New
Zealand as detailed in this National Nested Grid (NNG) document.

This specification guide represents a set of specifications for spatial location and resolution
for grid cell data that is accepted by jurisdictions of the Australia & New Zealand Land
Information Council (ANZLIC). Government and other agencies in these jurisdictions are
expected to adopt the aspirational specifications in managing their grid cell data as far as
practical to facilitate sharing and reuse of the data. While this may be adopted via
institutional administrative arrangements, this is not mandated by any legal means. In
practice, this guide provides a point of coordination for managing gridded data and the details
are expected to be reviewed regularly. This document is to be kept as a living document to
reflect data custodians and users needs.

1.2 SCOPE CLAUSE

This specification guide defines the common hierarchical grid system, in which grid cell data
from different sources and formats are managed. The guide covers the following elements:

e Coordinate system

e Datum
e Point of origin of individual grid layers in the hierarchical grid system (upper left
corner)

e Cell size (resolution)

1.2.1 Coordinate system

All coordinate systems described are spatial reference systems specified by their
corresponding European Petroleum Survey Group (EPSG) codes. They cover projected grids
that are based on one or more map projections and unprojected grids, based on latitude and
longitude. Each EPSG code specifies the required parameter set to define the reference
system and is used as a consistent referencing mechanism for the coordinate systems in this
guide.
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1.2.2 Datum

The datums specified in this guide are consistent with the choice of the spatial reference
systems adopted for the unprojected and projected nested grids. No change of datum away
from the one proscribed is allowed to maintain compliance with the NNG specification.

1.2.3 Point of Origin

The point of origin of the unprojected grid is the (0,0) lat-lon coordinate of the global
unprojected grid specified in the guide. This is the point where the prime meridian crosses the
equator.

The point of origin of each projected grid system in the guide specifies the (x,y) coordinates
(in metres) of the upper left (north-west) corner of the grid system. The point, which may be
just inside or outside the extent specified in the corresponding EPSG code, is chosen
arbitrarily for two purposes. One purpose is to ensure that the grid covers the agreed land
mass and extended boundaries concerned, i.e., Australia, New Zealand and the Antarctica.
The other purpose is to ensure the coordinates of the grid cells at different resolution will
remain as whole round numbers, not decimal numbers. The latter could bring unnecessary
storage and computational issues in future.

1.2.4 Cell Size
The cell sizes for this guide are selected on two direct considerations:

(a) Reasonable coverage of the main grid sizes of importance to the user community:
(i) while the original nominated cell sizes for the unprojected grid are in degrees, minutes
and seconds, they are converted into decimal degrees for ease of computation
(ii) the grid sizes for projected grids are in metres (m)
(b) Maintaining a “nesting” of cells, or alignment of cells of different resolutions.

Nesting is a desirable property but the cell sizes nominated for this guide do not support a
simple consistent nesting sequence. To resolve this issue all the required cell sizes are
included but distributed between 2 series of cell sizes. Each series is designed to support a
simple nesting sequence.

This “dual series” of supported resolutions applies to both the projected and unprojected
specification for each grid via a set sequence of supported resolutions. All the resolutions
specified in the cell size tables (Table 2 in section 2.2.4 and Table 4 in section 2.3.4) are
supported by this guide, it is up to the user to decide if the nesting property is important for
their application and enforce the series selection if required.

From the consultation process used for creating this guide, the user community indicated that,
as a general trend, the unprojected grid was more suited to the larger cell sizes and that map
projection was more suitable for the coverage with smaller cell sizes. The cell size range is
summarised in Table 1.
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Table 1: Cell size range and preferred projection type

Projection Type Applicable Range
Unprojected 10° - 0.0002778° (Decimal Degrees, ~17)
Projected 1000mto 1m

1.2.5 Out of Scope
The following are out of scope of the current Guideline:

(a) Lattice based data collections, i.e., data collected at sample points located at line
intersections of a pre-defined grid (lattice).

(b) Metadata. This is covered by other relevant ISO and OGC standards in particular the
1SO19115-2, 1SO19139-2 specifications. These standards are endorsed for use by
ANZLIC and this guide does not change this status.

(c) New projection specification. This guide only considers the well-known projections in
use at the time of writing.

(d) The well-known specialist projection, UTM, is excluded as each UTM zone has a limited
coverage,

1.3 APPLICATION CLAUSE

This Guide specifies the fundamental parameters that define the extents and positions of grid
cells in a set of agreed nested grids. The nested grids in turn form a consistent framework to
organise the marine and terrestrial attributes needed to describe and assess the social,
economic and environmental conditions of Australia, New Zealand and Antarctica.

1.4 REFERENCE DOCUMENTS
Normative Reference

N/A

Informative Reference

CHAN, T., FRANKISH, G. and FARRELL, S.2010. A National Grid Cell Data
Infrastructure: Significance of a Hierarchical Grid System and Cooperative Research Centre.
Paper presented at GSDI 12 World Conference: Realising Spatially Enabled Societies. 19-22
October 2010. Singapore. Accessible at http://www.gsdi.org/gsdiconf/gsdil2/papers/78.doc

Related documents
N/A
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1.5 DEFINITIONS CLAUSE

Term Definition

C-Squares geocoding convention developed by Tony Rees of CSIRO and adopted by many marine
and atmospheric research projects.

Cell A single area where the data value is constant or represents a single observed value. A
cell is defined by a location and an extent ( resolution ) value.

Grid A pattern of regularly spaced lines in two dimensions. It is often used to represent
collection of data points observations that are equally spaced in the principle coordinate
directions, each data point may be represented by a lattice point or a cell.

Grid layer A grid that has a defined cell resolution.

Hierarchical Grid
System

A collection of grid layers with cells of a higher resolution grid layer nested within cells
of a next lower resolution grid layer. Each hierarchical grid system conforms to a defined
coordinate system.

Lattice

Collection of points at the line intersections of a Grid area.

WMO Squares

A well-known geocoding convention based on the grid specification adopted by the
World Meteorological Organisation.
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SECTION 2 GRIDS

2.1 INTRODUCTION

These specifications here are organised into two sections according to the respective
coordinate systems.

(a) Unprojected Grid Specification.
This relates to grid systems that are not referencing a map projection and use geographic
coordinates that give varying cell sizes.

(b) Projected Grid Specification.
This relates to grid systems, each of which references a projected map system in its
definition. Within this section of the specification there are references to 3 map
projections for each region of interest to the ANZLIC community.

In each section, the other elements of the specification, that of: datum, point of origin and cell
sizes, are described.

2.2 UNPROJECTED GRID SPECIFICATION

2.2.1 Coordinate System

A key use case for unprojected data is derived from the need to share information between
international jurisdictions and contribute to global spatial data infrastructure and research
projects. To aid this objective the starting point chosen for the reference is based on the
WMO Squares concept™ (Figure 1). This is a uniform 10 x 10 degree grid centred on the
origin of the latitude and longitude (0,0) as denoted by the small red dot at the centre of
Figure 1.

]

LIt is important to note that WMO squares is a geocoding concept and not a coordinate system but it is a regular
well known geographic reference as well.
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Figure 1: WMO Squares / Top level Nested Grid

2.2.2 Datum
The NNG uses the ITRF 2005 datum?.

2.2.3 Point of Origin

The point of origin is the latitude and longitude (0,0), highlighted in red near the centre in
Figure 1 WMO Squares.

2.2.4 Cell Size

The suggested resolutions supported begin at the same level as WMO squares concept, for
example, the 10°x10° grid, the coarsest resolution. The subsequent resolutions are listed in
Table 2.

Table 2: Supported cell sizes for unprojected NNG

Cell Size — Decimal Cell Size — Degrees Series 1 Series 2
Degrees

10 10° 0'0" X X

5 5° 0'0" X X

25 2°30'0" X

1 1° 0'0" X

0.5 0°30'0" X X

0.25 0° 15'0" X

0.1 0°6'0" X

0.05 0° 30" X X
0.025 0°1'30" X

0.01 0° 0' 36" X

0.005 0°0'18" X X
0.0025 0°0'9" X X
0.0008333° 0°0'3" X Unsupported
0.0002778 0°0'1" X Unsupported

% This datum’s EPSG code is 6869. This is used by several CRS, any of which can be used as a suitable basis for
the unprojected grid, For example, EPSG 4896 CRS is an ITRF 2005 based system

® Note this is not a rational number and care must be taken with the mathematics associated with accumulating
these types of values. i.e. computational error may be significant when using large grids and small resolutions.
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2.3 PROJECTED GRID SPECIFICATION

2.3.1 Coordinate System

For the projected NNG specification there needs to be a “region” approach used as it is not
feasible or good practice to assign grids outside their defined regions. To this end the
projected system will use the most appropriate projection for the region considered. This is
not seen as an impediment to most calculations as projected grids are much more commonly
used for the definition of land oriented measurements. The three regions that need to be
considered separately are:

(a) Mainland Australia and Tasmania (MAT)
(b) New Zealand
(c) Antarctica

In addition to the three separate regions, there is also global position and orientation of the
landmass to consider in the choice of projection. Many respondents to the consultation
process used to acquire information to this specification guide have indicated that an “equal
area” projection is justified when the target audience for the information is interested in an
“accounting” type function, i.e., this projection allows simple area and coverage calculations.
This suits MAT quite well but for the Antarctic the projection does not suit the mathematics
particularly well and for New Zealand already has an established projection in use to achieve
this objective.

To accommodate these differences the workgroup chose not to enforce a universal projection
for these three regions. The projection selected for each is based on the needs for the region it
Serves.
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Table 3: Appropriate map projections for the three key regions of Australia and New Zealand

Region Projection Title Projection Point of Origin
EPSG code
Mainland Australia and | Australian Equal Area Albers 3577 -2690000, -1000000
Tasmania (Figure 2)
New Zealand New Zealand Transverse Mercator 2193 9830000, 6217000
2000
(Figure 3)
Antarctica Antarctic Polar Stereographic 3031 -3000000, -3000000
(Figure 4)

The extents defined in the table above cover the main land mass and nearby islands of each
region of interest. For outlying islands that are not in the projected extents the projection
choice is not defined in this specification and may be subject to revision of this specification.
At present covering these outlying cases the unprojected grid specification should be used by
preference.

2.3.2 Datum
All three projections are based on datum specified in the projection details.

2.3.3 Point of Origin

The points of origin of the three projections are marked by the upper left corners of the grid
systems illustrated in Figure 2, 3 and 4 below. The coordinates of each point are documented
in Table 3 above.

Each point of origin has been selected to ensure that the resulting grid covers the full area of
the region in question. The origin may not align with the coordinates of the upper left (North-
west) corner of the projection definition.

Appendix A (steps 15 & 16) illustrates the logic of the choice of the origin to cover the region
of interest.
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Figure 2: Australian National Nested Grid Coverage based on EPSG 3577

©QaIs 012

Figure 3: New Zealand National Nested Grid based on EPSG 2193
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Figure 4: Antarctic Nested Grid based on EPSG 3031

Table 4: Supported cell sizes for projected NNG

Cell
Resolution

Series 1

Series 2

1000m

500m

250m

100m

50m

25m

10m

5.0m

2.5m

1.0m
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3 NNG COMPLIANCE

3.1 Compliance Validation

The specification of the four parameters of NNG in the sections above allows the easy
validation of the compliance of an existing grid cell dataset to the NNG. The computational
procedures are illustrated in Appendix B for reference.

3.2 Compliance: Value of Constrained Cell Resolutions

The constrained cell resolutions of the NNG allow the efficient resampling of data for
customised analyses. This is illustrated by a scenario of data upscaling as described in
Appendix C.
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Appendix A

GRID GENERATION PROCEDURE

A1l Scope:

This procedure is only applied to the development of projected grids for the National Nested
Grid Project.

A2 Software Required

e QGIS1.6
e QGIS 1.6 plugin “Shapefile Structure Viewer and Editor” from (http://www.bc-
consult.com/free/bccshpv.html)

A3 Data Required

e Australian Outline Shapefile (NNG Specification\outlines\australia.shp)
e New Zealand Outline Shapefile (NNG
Specification\outlines\nz_mainland_only_mp.shp)

e Antarctica Outline Shapefile (NNG
Specification\outlines\world NAME__ ANTARCTICA.shp)

A4 Procedure - Australian Mainland and Tasmania National Nested Grid
Generation

1. Start QGIS 1.6
2. Import Australian Outline from Shapefile (NNG Specification\outlines\Australia
Outline\australia.shp)
3. Go to “Settings -> Properties”
a. Ensure the “Enable ‘on the fly’ crs transformation” is checked


http://www.bc-consult.com/free/bccshpv.html
http://www.bc-consult.com/free/bccshpv.html
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-
# Project Properties

General Coordinate Reference System (CRS)

R Enable 'on the fly' CRS transformation

Identifiable layers

BN

Coordinate Reference System Authority 1D D B
- WGS 84 EPSG:4326 3452
- WGST2 IGNF:WGST2G 10050
I - Wake Island 1952 EPSG:4733 3576
- Wallis - Uvea 1978 (MOPTE) IGNF:WALLTBGEQ 10049 [I
- World Geodetic System 1984 IGNF:WGS84G 10051
- Xian 1980 EPSG:4610 3463
i Yacare EP5G:4309 3439 @
+proj=longlat +ellps=\WG584 +datum=WG584 +no_defs
Search
Authority | All ~ Search for |ID - Hide deprecated CRSs
Find
Recently used coordinate references systems
Coordinate Reference System Authority ID D
WGS 84 EPSG:4326 3452
MNZGD2000 / New Zealand Transverse Mercator 2000 EP5G:2193 177
WGS &4 / Antarctic Polar Sterecgraphic EPSG:3031 996
GDAS4 / Australian Albers EP5G:3577 1535

Ensure the EPSG:4326 coordinate system is selected

c. Hitapply and close

Y

RS
Fle Edt Yiew Loyer Setngs Plugins Yector Bater Help
@ Ed 3 RRPP rORL2BIEYALRITEMMA w
P e TEPRRe N [@AARALR L0
ZadonRo A0 NBRIADC N BMRMUASOD
e Bix
© % @ sustralia
H
Comtosn Cnrn &%
o
22
«| Copy o cibamrd
4 Start capture.
Coordinate 12566462 Scale |[1201 (@)% Render | lig)

Note: this is a geographic projection to start with
Create a “Bounding box” in a new vector layer
a. “Layer -> New -> New Shapefile Layer”

b. Leave the type as point
c. Add and attribute

= Name id

=  Type Text data
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=  Width 80
= “Press “Add to Attribute list”
d. Press “OK” to complete the function
e. Save the Shapefile as “bounds.shp” in the “NNG Specification\Australia
NNG” Directory
6. Edit the bounds layer to add the initial origin point
7. Create a approximate point
a. “Toggle editing” with the bounds layer selected
b. Select “Capture point”
c. Using the cursor place a point in approximately the correct position using the
mouse.
Give this point the id “lower left” in the attribute box
Save the edits using the save button on the edit toolbar
f. “Toggle Editing” again to exit edit mode for this layer

8. Refine the Position of the origin
a. “Select the bounds layer” ( Note: it should be selected already )
b. Select the “Plugins -> Vector ->Shapefile Viewer” function
c. Edit the point position to be exactly the E108,N-45 coordinate

I EEECEOBBEE 3E e

EPSG:4326 - +proj=longlat +elips=WG584 +datum=WG584 +no_defs

oo m| )| id |
108 -45 0 lower left

Min X 10&.000000

Min ¥ -45.000000

Max X 10&.000000

Max ¥: -45.000000

= = e i

d. Save the point and exit the dialog

9. Repeat step 7 and 8 with the E155,N-45 Coordinate labeling it as “lower right”
10. Repeat step 7 and 8 with the E155,N-10 Coordinate labeling it as “upper right”
11. Repeat step 7 and 8 with the E108,N-10 Coordinate labeling it as “upper left”
12. The points should not be visible in QGIS
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Bl Edt View Lsyer Setngs Plugins Yector Buster Help

ma@dads RRP¥ rORZBIEY LRI TEK®A =
P e DmORRe T [QRARAQLR PO

ZAeRo Pyl o000V A0C N RNAAAOGD
Enit_boum

& % @ oustralia
o

) P x

o Start capture

Toggles the sciing state of the current iaysr

(8] Coordinate 158.66.6.86 [Scale |[115188444

[©]* Rencer | i)

13. Create an unprojected grid for future reference

a. Select “Vector -> research tools -> vector grid”

b. Select the “bounds” layer in the dialog

c. Press update extends from layer

d. Enter 5 in the X parameter box

e. Enter a file name grid before transform S5deg.shp when the “browse” dialog
box opens

f. Press “OK”

g. Add the layer to the TOC and make the fill value “none”
B s ———————

Ble 4t Yow Ly Setng Bugne Yoo Bter Hep
Tmad&s RRPP rOREABIEPAITLKMMT W
$ e TEPRR« L [@AAAALR PO

ZEdeRo 20 ORI ADC maNMRUAAOD

o+ strt apare

(s | st [ @) Reoe | 85

E|
[

@

Toggles e eing stateof e curen taer [

14. Test the “on the fly projection” capability of QGIS

a. Select “Settings -> project properties”
b. Find the “EPSG 3577” projection using the “find” function in the dialog.
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: :

General Coordinate Reference System (CRS) Identifiable layers

X Enable ‘on the fiy' CRS transformation

Coordinate Reference System Authority ID D []
- GDASA / Australian Albers EPSGSTT 1535
- NAD27 / Alaska Albers EPSG:12064 032 D
- NAD27 / California Albers £PSG:2209 1267
- NADS3 / Alaska Albers £PSG:2338 1206
- NADS3 / BC Albers EPSG:3005 070
- NADS3 / California Albers EPSG2310 1268
 NADS3 / Florida GDL Albers EPSG12086 1049 @
4proj=aea Hat_1=-18 +at_2=-36 +at_0=0 +lon_0=132 +x_0=0 +y_0=0 +elps=GRS30 +towgs84=0,0,0,0,0,0,0 +units=m +no_defs
Search
Authority | Al ~| Searchfor (D |+ Hide deprecated CRSs
Find

Recently used coordinate referances systems

Coordinate Reference System Authority ID j0}
NZGD2000 / Mew Zealand Transverse Mercator 2000 EP5G:2193 177
'WG5 84 / Antarctic Polar Stereographic EP5G:3031 996

GDA4 / Australian Albers EPSG:3577
WG5 84 EPSG:4326 3452

Select the EPSG 3577 projection

Press “apply” ( Note: the map will disappear )
Close the dialog

And do a full zoom

T Bt Y Loyw Seog Pogm cor Bote
AaEB &S RRPP -ORLGBIEPALITITUYMMAE W
P e TEPRReA QAARALA O

90808 AD sav M ASO0

h D o0

g. Note the “bend” of the lines of equal latitude in this projection. This is
significant as choosing a “top left” coordinate in this projection must take this
into account.*

15. Investigate the consequences of creating a grid system in this coordinate reference
frame
a. Select “Vector- > data management tools -> export to new projection “
b. Select the “bounds” layer to be the “input vector layer”

*“This particular issue causes a lot of confusion.
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c. Make the “output spatial reference system” to be the EPSG:3577 projection

,,'f‘E Export to new projection EE

Input vector layer

bounds -

Input spatial reference system

+proj=longlat +ellps=WGE584 +datum=WG584 +no_defs
Qutput spatial reference system
® Use predefined spatial reference system

=GRS30 +towasd4=0,0,0,0,0,0,0 4units=m +no_defs

Import spatial reference system from existing layer

[ grid_before_transform_5deg | ]

Import spatial reference system:

[ +proj=longlat +ellps=\WG584 +datum=WGE584 +no_defs ]

Output Shapefile

1/Australia NNGtmp bounds_transformed_to_epsg3577.shp

[ 0% | | ok | cos
d. Press OK
e. Add layer to the TOC
f. Select the “bounds_transformed to epsg3577” layer
g. Select “Vector -> research tools -> vector grid”
h. Select the “bounds_transformed to epsg3577” layer in the dialog
i. Press update extends from layer
j.  Enter 250000 (metres) in the X parameter box

k. Enter a file name grid_after_transform_to_epsg3577_250km when the
“browse” dialog box opens

I. Press “OK”

m. Add the layer to the TOC and make the fill value “none”
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From this grid we can see that the regular grid in the EPSG 3577 projection
does not take into account the “upward” bend caused by this projection and
indicated that the choice of the “extents” of the validity of the projection is not
a good choice for the NNG origin for this domain.

16. Revising the origin of this grid to ensure coverage in EPSG coordinates

a

—h D OO T

Hide the grid_after_transform_to_epsg3577 layer

Select the “bounds” layer

Select “Vector - > data management tools -> export to new projection “
Select the “bounds” layer to be the “input vector layer”

Make the “output spatial reference system” to be the EPSG:3577 projection
Set the output file to “bounds_transformed to epsg3577 adjusted”
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,ﬁ Export to new projection

Input vector layer

bounds > |

Input spatial reference system

+proj=longlat +ellps=WG584 +datum=WG584 +no_defs
Qutput spatial reference system
@ Use predefined spatial reference system

=GRS80 +towgsd4=0,0,0,0,0,0,0 +units=m +no_defs

Import spatial reference system from existing layer

[ grid_before_transform_Sdeg | - ]
Impaort spatial reference system:
[ +proj=longlat +ellps =\WG584 +datum=WG584 +no_defs ]
Output Shapefile
1/Bustralia NNG/tmp/bounds_transformed_to_epsg3577.shp
0 0% | [ o || cus
7|
b
Press OK

Add layer to the TOC

Select the “bounds_transformed to epsg3577 adjusted” layer

Select “Vector -> research tools -> vector grid”

Select the “bounds_transformed to epsg3577 adjusted” layer in the dialog
Select the “Plugins -> Vector ->Shapefile Viewer” function

. Edit the “top left” point position to be exactly the -2690000, -1000000

% Shape Viewer: bounds_transformed_to_epsg3377_adji

2 @-@..-..- /(2] (@](0] (@

lat_1=-18 Hat_2=-36 +Hat_0=0 Hon_0=132 +x_0=0 +y_0=0 +ellps=GRS80 +towgsd4=0,0,0,0,0,0,0 +units=m +no_defs

(2 \J] (Id) id =
1| -1968142.979859 | -5098960.446656 0 lower left
2| 1887044519799 | -5083872.254592 1 bottem right
3| 2579169.854819 | -1281018.475723 2 top right
1 -2680000.000000  -1000000.000000 3 top left
5
6 Min X: | -2690000.000000
7 Min¥:| -5098960.446656 @

n. Save the point and exit the dialog
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Select “Vector -> research tools -> vector grid”

Select the “bounds_transformed to epsg3577 adjusted” layer in the dialog
Press update extends from layer

Enter 250000 (metres) in the X parameter box

Enter a file name “grid after transform to epsg3577 250km_adjusted” when
the “browse” dialog box opens

Press “OK”

@
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u. Make the grid transparent



26

the Spatial Information Council

AN ANZLIC
4

Gt

B £t Yew Lye Setings Pugins Vector Buter belp

S WNA/EA

I ’Tﬁ‘f o

|
!
il

Togpis he g st ot e cumnizyer B Cooans Terawa s Scue |[1zz70%57 @)% Renser |

v. The entire region of interest is now covered with a rectangular grid in the
EPSG3577 coordinate reference system.

17. Conclusion
a. Projection EPSG 3577, origin -2690000, -1000000
b. Note 1: technically the origin is outside the specified bounds of the projection.
This cannot be avoided as the unprojected bounds cannot be represented in a

regular grid pattern in this projection.
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Appendix B

PROCEDURE OUTLINE FOR NNG COMPLIANCE

(a) Assume you have selected a resolution for the grid

(b) Assume 25m Grid

(c) Calculate the top left coordinate of the first cell in the local grid

(d) Take the NNG origin and subtract the origin values from corresponding local grid values

(e) For each difference divide by the resolution being used

(F) Check the Diff X is a whole number. If yes proceed to (g) else stop the grid is not aligned
with the NNG

(9) Check the Diff Y is a whole number. If yes then the grid is NNG compliant otherwise it is
not aligned with the NNG.

B1 Example: Grid Validity 1 - Projected Grid incompatible cell definition

Consider a 25 metre cell centred at coordinate 1143525, -4180414 the EPSG3577 coordinate
reference system.

Is this cell compatible with the National Nested Grid Specification?

(a) Calculate the top left coordinate of the cell. (1143525 — 12.5 = 1143512.5), (-4180414 —
12.5=-4180426.5)

(b) The NNG origin is -2690000, -1000000

(c) Hence the difference values are 3833512.5, -3180426.5

(d) Divide the differences by 25 result in 153340.5 , -127217.06

(e) The first difference value is not a whole number hence the easting is not compliant with
NNG

() The second difference value is not a whole number hence the northing is not compliant
with the NNG.

B2 Example: Grid Validity 2 - Projected Grid compatible cell definition

Consider a 25 metre cell centred at coordinate 1143512.5, -4180437.5 the EPSG3577
coordinate reference system.
Is this cell compatible with the National Nested Grid Specification?

(a) Calculate the top left coordinate of the cell. (1143512—- 12.5 =1143500 ), (-4180437.5 —
12.5=--4180450)

(b) The NNG origin is -2690000, -1000000

(c) Hence the difference values are 3833500, -3180450

(d) Divide the differences by 25 result in 153340 , -127218

(e) The first difference value is a whole number hence the easting is compliant with NNG
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(F) The second difference value is a whole number hence the northing is compliant with the
NNG.

B3 Example: Grid Validity 3 - Unprojected Grid incompatible cell definition

Consider a 0.05 degree cell centred at coordinate 144.025, -34.0 in an unprojected coordinate
system.

Is this cell compatible with the National Nested Grid Specification?

(a) Calculate the top left coordinate of the cell. (144.025- 0.025 =144 ), (-34.0— 0.025=-
34.025)

(b) The NNG origin is 0.0, 0.0

(c) Hence the difference values are 144, -34.025

(d) Divide the differences by 0.05 result in 2880 , -680.5

(e) The first difference value is a whole number hence the easting is compliant with NNG

(f) The second difference value is not a whole number hence the northing is not compliant
with the NNG.

B4 Example: Grid Validity 4 - Unprojected Grid compatible cell definition

Consider a 0.05 degree cell centred at coordinate 144.025, -34.025 in an unprojected
coordinate system.

Is this cell compatible with the National Nested Grid Specification?

(a) Calculate the top left coordinate of the cell. (144.025- 0.025 =144 ), (-34.025—
0.025=-34.05)

(b) The NNG origin is 0.0, 0.0

(c) Hence the difference values are 144, -34.05

(d) Divide the differences by 0.05 result in 2880 , -681

(e) The first difference value is a whole number hence the easting is compliant with NNG

(f) The second difference value is a whole number hence the northing is compliant with
the NNG.
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Appendix C
UP SCALING PROCESS

If data is available at a lower resolution and it is desired to conduct an analysis at a smaller
resolution normally the data would be “sampled” into the finer grid from the larger grid
resulting in merged grid of values. This process is “up scaling”.

In the case of the NNG this process is made easy as the grids with different (but constrained)
resolutions have a guaranteed alignment within the NNG Scheme. In simple terms the lower
resolution data can be assigned to lower grid values with no loss of fidelity that might arise
from a resampling application.

High Resolution (25m) ( aligned

Low Resolution ( 50m ) NNG )
Cell RN e i
Value *****jg\ ,,,,,,,,,,,,,,
#1 I e s ISR SR, 4@ @

Note: 4 well defined contributions to high
resolution cells

Figure 5: Assigning values to higher resolutions in NNG
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Low Resolution ( 50m ) High Resolution (25m)

Cell
Value —
#1

Note: 9 variable contributions to high resolution
cells

Figure 6: Assigning values to non NNG aligned cells
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Appendix D

SUMMARY OF NATIONAL NESTED GRID SURVEY RESULTS

Key Stakeholders were provided with a Survey Link.
The results received are summarized below.

Key Findings — Common
e Projected and unprojected grid systems are both required for the use of gridded data.
e Current usage patterns are driven by a combination of target application and sensor.

e Policy making support activities are a key driver for remote sensing using gridded data.

Key findings unprojected grids

e Unprojected grids should be aligned with international conventions such as WMO
squares.

e There is no “preferred” cell size discernible from the client base only a trend to higher
resolution data is detectable.

e There is significant support for including cell sizes to 1s resolution.

Key findings for projected grids

Projected grids should be appropriate for the area being described.
o Australia and Tasmania
o New Zealand Mainland

o Antarctica

There is no identifiable need for a single projection for all territories.

UTM is used by a significant number of the remote sensing community.

Equal area projections are beneficial but not essential for this specification guide.

http://creativecommons.org/licenses/by-sa/3.0/




